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A BRIEF INTRODUCTION TO THE INTERNET

The Internet is not so new - it already had its beginnings in the 1960s, when computers in

the United States Department of Decence agencies and agencies with decence research

projects were linked by data lines, so that information could be transferred between the

computers. These network was begun to expand when other links were created to other

United States government agencies, research centres, and universities. The result of this was

a national research network called ARPANET in 1969. Through this network,
communicationsprotocols (standard ways of sending and receiving messages and files, and

ways of communicating between computers) were developed. Today national and regional

computer networks in more than one hundred countries are linked to what is today called

the Internet. Estimates ofthe number of users linked through the networks are in the range

of 50 million to 60 million. The Internet thus is a network of networks.

The Internet is not an Institution where you can become a member, but it can be described

as an idea or a concept. There is no central organisation managing the Internet, but ceratin

functions are managed by special agencies and some decisions are taken by special

committees. The Internet originated because technology made it possible, and in response

to a necessity for widespread computer communications.

The Internet has become prominent during the last 7 years, because of the availability of

personal computers, and the development ofuser-friendly software to use the Internet. This

was followed by the World Wide Web in 1992. The development of multimedia "Web

browsers" like Netscape and the Internet Explorer has provided the momentum for growth

over the last four to five years. These developments have made the Internet easier to use as

Internet service providers could present their information in a very attractive way.

Two single technical decisions allowed the network to function:

► Packet switching technology,

making it possible that data from different machines could share common

transmission lines.

Design of TCP/IP Protocol

Transmission Control Protocol/Internet Protocol was developed in the mid 1970's

provided standard means by which computers could talk to each other. It became

and is the standard way to connect the computers over the Internet.

TOOLS OF THE INTERNET

There are tools that help people to:
• "browse" the Internet, with World Wide Web with browsers like Netscape and

Internet Explorer

to locate and copy files or documents on millions of computers - FTP (File Transfer

Protocol) with ARCHIE.

send electronic mail (email) to its destination - Electronic Mail or in short email.

• to communicate with groups and organisations - USENET news groups.

• to link with distant computers - Telnet.

This course will provide a basic introduction to some of the Internet tools and services;

activities will help you to develop the skills in using the Internet.



RESOURCES ON THE INTERNET

The resources, services, databases, home pages, discussion groups, electronic bulletin
boards, conferences, news groups, news magazines, electronic reference works, speech,

music, etc. on the Internet are of a great variety. There is something for everybody on the

Internet. Professionals and workers in a wide range of fields can find information they are

interested in - information to encourage hobbies and entertainment, as well as business and

research.

TYPES OF ACCESS TO THE INTERNET
There are many names by which access to the Internet is called, but let us stick to these

simple definitions:

1. PERMANENT CONNECTIONS

In this case your computer is connected directly via a network card and line to a network
using TCP/IP, which on its turn is part of the Internet. Also called direct access.

2. DIAL-UP CONNECTIONS

With this connection you need access to a telephone line, and with a modem you

can phone the ISP, and get connected. The ISP charges a fixed monthly fee, and

you can log onto the Internet, when you want to. ISP's offer different options of

access and the amount you pay, e.g. email only, hours per month, amount of data

received or transferred, etc. This also is a TCP/IP connection, like the permanent

connection,

HOW TO GET STARTED

WHAT DO YOU NEED TO CONNECT TO THE INTERNET?

You will need a computer (at least 386 Mhz speed, with 8 MB of memory and 500 MB

hard disk), a modem, communication software, and access to a telephone line. If your work

has a local area network (LAN) that is connected to a local Internet Service Provider (ISP),

you can connect through this network to the Internet, and then you do not need a modem

that is connected to your computer. Your business will need to have Internet access (that

is, an account or user ID and password) at the Internet service provider

The MODEM

Access to the Internet is chiefly determined by the speed of your modem. These come in

speeds between 2400 and 56 000 bps (bits per second). The higher the speed the quicker

your connection speed should be, although there are other factors which influence your

speed as well. You are only connected to the Internet as long as your modem connection
via your telephone line is on - if you break the connection you are off the Internet. If you

have to buy a new modem, go for a 56 000 bps modem, but do not buy one that is less than

28 800 bps.

Bits per second (bps): is the measure of how much data a modem can transmit. A computer

stores data in bits, which can either be 1 or 0. The actual rate at which your modem
transmits will vary depending on the telephone line conditions, the computers at the other

side of the connection, the load of the data line at that stage, etc.

How to choose your ISP:



Once you have chosen your ISP, and paid your link-up connection, and your monthly or
annual fee, he will provide with a printout of your user name, your password, the name of
the computer from where you download email and sent email to, and IP (Internet Protocol)

numbers, which you will have to fill in when you configure your computer for the

connection.

INTERNET TERMINOLOGY:

> Login names / user id

To get connected, you will need a Login name (user name, account name). This is
the name ofyour account, the name you will have to type in every time you access

the Internet, but with most of the dial-up software the system stores you name and
password, and automatically sends it when you login. It tells the ISP who you are

so that you can be allowed on the network. Your login name is part ofyour address

when others for example want to send email to you. It can up to 8 characters long,

and it is case sensitive.

> Passwords

You will need a password, or a secret code to access your ISP. This can also be up

to 8 characters, and it is also case sensitive. Choose a password that is a mixture of
numbers and letters, and not a common word, e.g. Gu8Bxl4. Do not give your

password to anybody, and don't type it while somebody looks over your shoulder.

> IP address / Host numbers:

Computers are registered as Internet nodes. An IP address consists of a set of 4 X

3 numbers, e.g. 196.20.18.181.

Your ISP will provide you with the IP address of his site which you will have to type

in when you configure your Internet connection.

1 Either your service provider gives you a number and you enter the number in your

TCP/IP software configuration, or

2. the system uses some method of automatically assigning you a number each time you

log on.

When you are on the Internet, your computer is connected to a computer that is connected
to the Internet.. Computers that are directly connected to the Internet are known as hosts,
and each one is assigned a unique number. This number is the address that the Internet uses

to send messages to their destinations. It can be compared to your postal address. Numbers
identifying the routers are used to get the message to the particular host. The number are

called IP addresses.

Domain names:

An Internet user is identified by his user name and domain name, such as

morgicyiafrica. com.na.

In this address, the user name is morg and the domain name is iafrica.com.na.



THE WORLD WIDE WEB (WWW)

INTRODUCTION

The World Wide Web (or WWW) is one of the newer sections of the Internet. It is a

"hypertext" system, where information and resources are linked, and users can move from

page to page, by simply clicking with the mouse on underlined (highlighted) words. The

base of the Web is the "home page", through which information is provided and links are

made. The Web is text and images of various kinds (e.g. photographs and maps), moving

images, sound files (music and voice). These documents, and the links between them,

comprise a "web" of information.

To use the World Wide Web, browser software is needed. Internet Explorer and Netscape

are currently the most widely-used browsers.

The WWW works on a "client-server architecture": a powerful computer or server stores

information in a particular format, and makes it available to users who have "client"

software that can access the information and present it on the user's screen. Different types

of "browsers") present the WWW information, in different ways. The information and

documents that the browsers display is in the form ofhypertext documents. Hypertext is text

(and images) with links (a small hand appears on the screen) to other text. The browsers

takes you from links or pointers from document to document in a way you can see ~ select

the pointer or link (by clicking with the mouse), and you are presented with the text or other

information that is clicked on.

The World Wide Web is changing the way people communicate all over the globe. This new

global medium is gaining popular acceptance faster than any other communications medium

in history. Over the last two years, the web has grown to include a vast array of information

- everything from stock quotes to job opportunities, bulletin boards to news, previews of

movies, literary reviews, and games. The type of information ranges from the most obscure

to the most globally important. People often talk about "surfing" the web and visiting new

sites. "Surfing" means following hyperlinks to pages and subjects you may never have heard

about, meeting new people, visiting new places, and learning about things from all over the

world.

Hyperlinks, are underlined or bordered words and graphics that have web addresses (also

known as 'a URL ~ Universal Resource Locator) embedded in them. By clicking a
hyperlink, you jump to a particular page on a particular web site. You can easily identify

a hyperlink. Hyperlink text is a different colour from the rest of the text in a web site.

This is an example of what hyperlink text looks like.

RESOURCES ON THE INTERNET
The resources, services, databases, home pages, discussion groups, electronic bulletin

boards, conferences, news groups, news magazines, electronic reference works, speech,

music, etc. on the Internet are of a great variety. There is something for everybody on the

Internet. Professionals and workers in a wide range of fields can find information they are

interested in - information to encourage hobbies and entertainment, as well as business and

research.

URLs
URLs are an critical concept for World Wide Web users. The URL, or "uruform_resource

Jocaior^ provides a unique "address" on the Internet for any Internet resource or service,



like you have a street address where you can be reached. It's like a postal address or a

telephone number. The URL is based on the Internet address of the computer on which

the resource or service is located, but it also includes codes for the type of resource or

service, and the path or directory in which the resource or service can be found. All

services, documents, images, files, computers, have URLs that identify their location on

the WWW. Typing any URL in the "Open" box and clicking "Open" will take you directly

to that resource or service.

Most URLs have 4 parts:

the protocol - that is how the document is accessed, e.g. http, ftp, telnet. For the

WWW you will mostly use http (hypertext transfer protocol).

* the host name (www.unesc.org) is the computer system where the information is

stored.

the directory (/docs) is the location on the host computer where the information

can be stored.

the file name (index.html) is the file name where the information is stored.

URLs for World Wide Web resources begin with http: / / and then the letters

and symbols that follow indicate to the computer system, the address of the

computer to which you wish to go, and then usually the path to the particular

resource or document that you want. The following are examples of URLs:

UNESCO
http://www.unesco.org

ECA

http://www.un.org/Depts/eca

What does it mean "Page not found"

The URL itself may be incomplete or incorrect, the page or information that the URL

pointed at may have been moved or deleted altogether. Ifyou are typing the URL, make

sure you are entering it correctly.

USING THE BROWSER TO LOOK AT INFORMATION

Netscape Communicator and Microsoft Internet Explorer are the 2 most used web

browsers. Just like you use Microsoft Word as a tool to do word processing or Microsoft

Excel as a tool to do spreadsheets and calculations, Netscape is a browser or tool for

navigating and accessing information on the web. The browser's toolbar shows the

controls for navigating the web and managing the formation you find there. The toolbar
provides a range of detailed functions and commands for managing the browser. The

address bar below the toolbar displays the current web site address being accessed. To

go to a new web site, you type the site's web address (URL) directly into the space on this

bar. When you're finished typing, press Enter on your keyboard.

Navigational Aids

The Netscape browser has some useful buttons on its toolbar.

Back and Forward Buttons

The Back button returns you back to a previously displayed page, usually the most recent

page. The Forward button returns you ahead to a previously displayed page. If you have

not used the Back button in a current session, the Forward button will be inactive.

Open Home Page Button

The Open Home Page button returns you to your default start page. The start page is the



page that you begin on when you open your browser,

Netscape Logo ( a Big N)
The Netscape logo in the upper right corner of your screen moves as your browser

accesses or downloads information. If the icon is moving for longer than you would like,

use the Stop button described below.

Search Button

The Search button opens a page that contains Internet Search tools. For your convenience

the,

Netscape Home page (www.home.netscape.com) provides you with all the search tools

you need.

Stop Button

The Stop button immediately stops the browser from accessing a link.

INTERNET SPEED

Internet traffic can slow your surfing speed

Internet servers allow many people to access a page at the same time. But not all servers

are equal, and some may not be able to keep up with the demands of many people's

browser requests. If it seems to be taking a long time to load a page, be patient. It's not

unusual for a page to take a while to access. If you try to access a page and see a dialog

box that says it's unavailable or busy, treat it just like the busy signal on a telephone and

try again later. It's a good time to explore other sites on the Web.

Modem speed makes a difference

For surfing the web, you will want to use a modem that runs at a speed of at least 28 800

Kbps. The faster your modem, the less time it takes to load graphics and the more

interactive the session can be. If you plan to doing a lot of web surfing, a faster modem

will enhance your experience.

, Large files will take longer to download

' The larger the file, the longer it will take to download it to your browser. If you find
yourself getting frustrated by slow connections, get a faster modem. It will improve the

quality of your web surfing experience.

Don't forget the Stop button

If the Internet Explorer logo in the upper right corner of your Internet Explorer toolbar

is active for an unusually long time, use the Stop button to halt accessing your request.

Reducing the time it takes for a page to download?
Go to the View menu on Internet Explorer, choose Options. Under the General section,

clear the check boxes that say Show Pictures, Play Sounds, Play Videos, and then click

OK. Now when you access a web page, only the text part of the page will download.

Computer viruses and the Web page?

Your computer cannot be infected by a virus by just clicking on a web page, even if it has

graphics or plays movies, sound or 3-dimensional files. However, if you download a new

program or application and run it, you run the same risk as you would running any new

program -- so you should consider whether you trust the site you are downloading the

program from. Nothing "automatic11 within the browser would cause a virus to get into



your computer. To be on the safe side, it is advisable to load an anti-virus programme on

your computer.

Bookmarks - creating a collection of favourite sites and pages
If you find useful resources on the Internet, you could note them down. But think of the
work, and also all the mistakes you could make when noting the URLs. But, as you explore
the Web you can keep a record ofuseful sites that you found. Netscape allows you to do

this through "Bookmarks". Just as a paper bookmark keeps your place in a book, so an
electronic bookmark keeps your place on the World Wide Web. It does this through a
-Bookmark" which lists all the sites for which you have marked. Netscape users will find
an "Bookmarks" icon on the menu bar at the top oftheir screen. To set a mark for a Web
page, open the page, then open the "Favorites" file and select the option "Add to

Bookmarks".

Saving the current page onto the hard disk of your computer

^ 1. On the File menu, click Save As File.
2. Double-click the folder you want to save the page in.
3 In the File Name box, type a name for the page, and then click Save.

When using this option, Netscape only saves the text on a page, not the graphics. To save
graphics as well, click on File > Edit page. When the page has been loaded, click on File

> Save as. Now the graphics will be saved as well.

Searching for text on a page

1. On the Edit menu, click Find in Page.

2 Type the text you want to find.

3 Change any settings as needed.

4 Click Find Next.

„ Copying information from a page into a document

^ l Select the information you want to copy by highlighting it with your mouse.

To copy the contents of an entire page, click the Edit menu, and then click Select

All.

2 On the Edit menu, click Copy.

3 Open the document (e.g. WordPerfect document) where you want the information

to appear, and then click the location where you want to place it.

4. On the Edit menu in that document, click Paste.

Note: , , ....

You cannot copy information from one Web page into another, unless your are editing it

with Netscape Composer, Microsoft FrontPage, or any text editor.

t, Changing your start page

/ 1 Go to the page you want to appear when you first start Netscape..

2. On the Edit menu > Preferences > Home page..

3 Click the Navigation tab, and then click Use Current Page.

Hints

If you are familiar with authoring Web pages, try creating your own start page, with



hyperlinks to your favourite Web sites. To restore your original start page, click Use

Default.

Changing the number of pages in the History list ^
1 On the Edit > Preferences Menu > Navigation >"Pages in history expire after .

2. Change the number in the window to change the days Netscape keeps track of your

pages.

Hints , . ,. . , .
For Help on an item, click at the top of the dialog box, and then click the item.

Security on the Internet
The Internet works by sending information from computer to computer until the

information reaches its destination. When data is sent from point A to point B, every
computer in between has an opportunity to look at what is being sent. This can pose a

security problem For example, you are viewing a book catalogue on the World Wide
Web and you decide to order a book online. This requires that you type information into

an order form, including your credit-card number. You know the clothing company in

question is reputable, so you type your credit-card number and other information, and then
send the completed form. Your information passes from computer to computer on its way

to the clothing company. Unfortunately, one of the computers in between has been
infiltrated by criminals who watch the data passing through that computer until they see
something interesting, such as your credit-card number. How often does something like this
happen? It's hard to say, but the important thing is that it's technically possible. And, as the

Internet grows, it could happen more and more.

Does Microsoft Internet Explorer help protect you and your data?
Many Internet sites are equipped to prevent unauthorized people from seeing the data sent
to or from those sites. These are called "secure" sites. Because Internet Explorer supports

the security protocols used by secure sites, you can send information to a secure site with
safety and confidence. (When you are viewing a page from a secure site, Internet Explorer

displays a "lock" icon on the status bar.)
Internet Explorer can also notify you when you are about to do something that might pose
a security risk For example, ifyou are about to send your credit-card number to a insecure

site Internet Explorer can warn you that the site is not secure. If the site claims to be
secure but its security credentials are suspect, Internet Explorer can warn you that the site
might have been tampered with or might be misrepresenting itself. To specify when Internet
Explorer should warn you, click the View menu, click Options, and then click the Security

tab.

Security certificates
There are two different types of certificates, personal and Web site. A personal certificate
is used when you send personal information to a client authentication server that requires
a certificate. For example, a personal certificate would contain information such as your

user name and password.

A Web site certificate is used when a secure Web site sends Internet Explorer a certificate
that provides certain information about security for that Web site. A certificate is issued
to a particular organization for a specific period of time. When you try to open that



organization's Web site, Internet Explorer verifies the Internet address stored in the
certificate and that the current date precedes the expiration date. If not, Netscape can
display a warning. For example, a Web site certificate would contain information verifying

that the site is secure and genuine. This ensures that no other Web site can assume the

identity of the original secure site.

Setting levels for Internet privacy

1. On the Security Padlock (left hand bottom side)and set your Options.

Hints

When you select these options, Internet Explorer will use personal and Web site security

certificates you have installed on this computer before you send and receive information

between secured Web sites.



BASIC HTML

The Development of HTML (Hypertext Markup Language)
The HTML language was developed at the CERN research laboratory in Switzerland. It

allows you to format text, add rules, sound, graphics, video, and save all this in normal text

files, or also ASCII files.

HTML is the markup language used to create World Wide Web documents. Although

official HTML specifications have been in development for some time, individual Web
browsers may recognize proprietary tags that are not included in the specifications. When

most people ask for a list of "all the HTML tags" they generally want to know which tags

they can include in their pages with reasonable certainty that people viewing those pages

will see what the author wants.

The official standards body for HTML is the World Wide Web Consortium (W3C). The
W3C has issued several versions ofthe HTML specification, including HTML 2.0, HTML

3.0, HTML 3.2, and most recently HTML 4.0. At the same time, however, browser

manufacturers, such as Netscape and Microsoft, have often developed their own

"extensions" to HTML outside of the standards process and incorporated them into their

browsers. In some cases, such as Netscape's <CENTER>

tag, these extensions have become incorporated into the official standard.

HTML 2.0, which codified the current state ofHTML as of June, 1994, is the baseline

standard that all browsers today — including text-based browsers -- should support.

HTML 2.0 reflects the original conception of HTML as a device-independent markup

language for displaying the organization ofinformation, rather than specifying exactly how

pages should be displayed. If

you want to be sure that all users will be able to view everything on your pages, use only

HTML 2.0 tags.

The HTML 3.0 draft, issued in 1995, attempted to build upon HTML 2.0 with the addition

of features such as tables and greater control of text flow around graphics. Although some

HTML 3.0 features were widely adopted by browser developers,

many were not. In some cases, alternative approaches implemented by browser developers

became more widespread than the "official" tags. The HTML 3.0 draft has now expired,

and is therefore no longer an official standard.
In January 1997, W3C adopted the HTML 3.2 recommendation, which was designed to

reflect and standardize generally-accepted practices. Therefore, HTML 3.2 includes the
HTML 3.0 tags that were adopted by browser developers such as Netscape and Microsoft,

as well as widely-supported extensions to HTML.

HTML 4.0, the current standard, became a W3C recommendation in April 1998. This

version includes a number ofnew formatting elements, changes related to scripts and style

sheets, and several modifications to make Web pages more accessible to people with

disabilities. The current versions ofmajor browsers should support all, or virtually all, these

tags.

For the future, W3C is working to reformulate HTML in the context of the extensible

markup language (XML), a broader and more flexible standard. For more information, see

the current W3C working draft, adopted in December 1998.

There are also some Netscape and Microsoft extensions to HTML that were not

incorporated into the official HTML standard. By popular request, they are listed in the
Bare Bones Guide to HTML. In deciding whether to use any of the tags listed as Netscape

or Microsoft extensions, remember that people using other browsers may not see your

pages rendered the way you intend.

in



BASICS OF HTML

The key to HTML is the tag - words enclosed in the smaller than sign (<) and the greater

than sign (>). If you view the text or source of an HTML file, you will see many ofthese
2 signs. You need a program, also called a browser, to view the contents in a more

readable format.

HTML tags are commands written between less than (<) and greater than (>) signs, also

called angle brackets, or triangular brackets, which tell the browser how to display the text.
There are opening and closing versions for many (but not all tags) tags, and the affected

tag is contained within these 2 signs. Both the opening and closing tags use the same

command word, but the closing tag carries an initial extra forward slash </)

EX: <EM>ECA Website publishing course</EM>

Attributes: .

Many tags have special attributes that offer a variety of options for the text contained

between the tags. This attribute is entered between the command word and the final greater

than symbol. More than one attribute may be used within a single tag. These are written

one after the other one with a space between each one.

EX: <TABLE BORDER>

Values:

Attributes can have values, and the appropriate one has to be selected from the small group

of choices.

EX: <BR CLEAR=ieft>

Quotation marks:

Values should be enclosed in double quotation marks. One may omit the marks it the value

only contains letters, digits, a hyphen or a full stop.

EX: <IMG SRO"eca.jpg" HSPACE="5">

Nesting tags:

When nesting tags, remember that not all tags can contain all other kind oftags. Tags that

contain entire paragraphs can hold tags that affect the individual words or letters, but not
the other way round. Order is also important - whenever you use a closing tag it should
correspond to the last unclosed opening tag - first A then B, then /B and the /A.

EX: <H1>ECA<EM> course</EM></Hl> (correct)

<H1>ECA<EM> course</Hl></EM> (wrong)

Spacing:
HTML browser ignore any extra spaces between tags in the HTML document. Also don t

insert an enter at the end ofthe line, it will not be displayed, you will have to insert a P tag.

Tags with automatic line breaks: Block-level tags in general include automatic logical

line breaks, e.g. header, which includes a line break. Inline tags e.g. (EM, B, IMG) which
only affect a few letters or words, do not automatically begin with a new line.

Special symbols.

Special characters which do not form part ofthe standard ASCII set, e.g. accents, umlaute,

will have to be entered with either name or number codes, ifyou use a Macintosh or DOS

based computer, e.g. &ouml or &#248 to get a 6.

There are 4 symbols that have special meanings in HTML documents: <, >, ", and &. If
these are entered into HTML document the browser will try to interpret them. To show
these symbols use the name or number code: &lt;BR&gt; to see <BR> in the page.

ii



URLs*
This is a name for an address of a web page on the Internet. See also the Introduction in

this guide. ,
The following protocols can be used: http, ftp, news, telnet, mailto - news and mailto do

not get the //after the colon.
Absolute URLs show the entire path to the file on the computer, while relative URLs

describe the location of the file with reference to the location of the requested file that
contains the URL itself. If the file is in the same directory, you can simply enter the file
name If it is one level up in the file hierarchy, you must use ../. It is not necessary to type

the protocol Generally it is better to use relative URLs, as it is easier to move files from
a local computer to a server, as long as the relative position of each file stay the same.

MINIMUM REQUIREMENTS FOR AN HTML DOCUMENT

To start your web page, the page should have the following minimum tags:

<!DOCTYPE HTML PUBLIC-//W3C//DTD HTML 4.0 Transitional //EN">

<HTML>

<HEAD>

<TITLE>

type the title, e.g. University of Namibia

</TITLE>

</HEAD>

<BODY>

text

text

</BODY>

</HTML>

Most web pages are divided into 2 sections: The HEAD and the BODY. The HEAD
section provides information about the URL of your web page as well as its relationship
with other pages on yout site. The only element visible to the user is the title of the web

page - it is a required element. You can also add META information here.

The BODY will contain your text, images, and formatting.

HTML Editors
It is good to have some knowledge of the basics ofHTML Language, however, you can

also make use of HTML editors, that have the same functionality as word processors.

There are many on the market, e.g. FrontPage by Microsoft, Netscape Composer,

CoffeeCup HTML Editor, etc. It is easier to use these, and they automate many of the

processes.

For this course we are going to use Netscape Composer, which comes with the

professional version of Natscape Communicator, and for the purpose of this course, it

provides all the functionality you need.

NETSCAPE COMPOSER:

Creating Web Pages

A step by step guide

1 Plan your web page! Have some outline on paper ready - text, links to other sites,

images, backgrounds, etc.

1 If you are familiar with a word processor type your text in it - but do not spend

time on the formatting of your document. In newer versions of word processors



like WordPerfect or MSWord, it is possible to publish your document to HTML,

and then you could format it at this stage already.

2 With the use of an HTML editor it is not necessary to remember all the HTML tags

and codes, because the editor does it all for you. However, it is good to the basics

ofHTML] so that you can solve problems if it does not do what you want it to be.
3 Open the document in the word processor where you typed it. Select all the text

(EDIT > SELECT ALL> and COPY the text onto the clipboard. Minimize the

word processor.

4. Open Netscape Composer. Click on STOP. Click on FILE > NEW DOCUMENT

> BLANK. You will be presented with a blank page, and a toolbar at the top of the

screen. Click on EDIT > PASTE. The text will now be loaded into the web page.

5. Save you wep page with the extension *.htm or html. Click on FILE > SAVE AS,

and provide a name. Make a note of the folder where it was saved to.

6. Now you can start to edit and format the page. Use PREVIEW to look at the page

as it would look like in Netsacape Navigator. To start from an page already created

in Composer.

Choose Page Composer from the Communicator menu. Open the File menu and

choose Open Page. Type the path and name of the file you want to use, or click

Choose File to search for the file.

7. Formatting Your Web Page: Use the HELP menu at the right hand top side to learn

more about it. It gives an explanation of the various formatting techniques.

HTML FORMS
The bulk of the material you will learn are the names of the markup tags associated with

Fill-in-Forms. They can be classified into subgroups:

Form Basics

Text

plain text entry

password entry

hidden entry

multi-line text areas

Menus

options menus

scrolled lists

Buttons

checkboxes

radio buttons

reset and submit buttons

HTML forms are required when one wants to query a database on the WWW.

Forms Theory

There is a lot more to a form than the HTML tags. In fact, the HTML form is, at most,

half the story. The other half is a program which resides on the Web server itself. This
program is written in a language such as Perl, C/C++, TCL, AppleScript, or another

Common Gateway Interface (CGI) /



language. The role ofthis CGI program (in our case isfrag.pl) is to accept the data which

the user inputs and then do something with it. What does it o? That depends on what the

program has been written to do. It could e-mail the data to someone, or add an entry to a

database, or write out a text file, or create a customized display, or just about anything else

you can think of.

A very common use for HTML forms is creating a feedback form, or other user-response

form. Usually, the feedback from the user is e-mailed to somebody. So how does this

work?

Where The Data Goes

Actually, data is passed from the HTML form to the CGI program in name-value pairs.

The value is whatever the user enters, and the name is the label used to identify that input.

Here is a very simplified example, but it is close enough for our purposes.

Let's say we have a form with three inputs: name, rank, and serial number. The inputs are

labeled NAME, RANK, and SN, respectively. The user enters the data "Eric" for the name,

"Very Low" for rank, and "123-45-6789" for the serial number.

The data sent to the CGI program would look something like this:

NAME = Eric

RANK = Very Low

SN= 123-45-6789 [&M ^ l
The program would then do something with each piece of data. For those ofyou familiar

with programming languages, you recognize what's going on here. The labels are variable

names, and the entered data are the values of the variables. Let's say each input is a

labelled box. In the preceding example, the labels would be NAME, RANK, and SN.

Whatever the user types in for a given box becomes the contents ofthat box. The boxes

are then all loaded onto a truck (i.e., your connection to the Web server) which hauls them

off to the CGI program. The program then unloads the contents of each box and does

something with what it finds. What it does depends on how it's

been programmed. An overly simple explanation, perhaps, but conceptually accurate.

No Two Names Alike

This leads us to a very important point: no two inputs can share the same name. Each input

has to have its own unique identifier, so that the CGI program can figure out which piece

of data belongs where. So if I use the name "ssn" to refer to a Social Security Number

input, and then later ask for the name of a nuclear submarine, I must use a different name.

User Input

3 *# ta* *idl »£

"sub" would work, as would "boat," but "ssn" is not allowed.

What happens ifyou do use the same name twice? Well, no error messages will pop up and

warn you about it. Ifyou have two inputs with the same name, what will happen is that the

browser will assign one or the other of the values which the user inputs to the name. The

one which is not assigned will simply disappear. This may lead to odd results from your



CGI program, but it isn't the program's fault. It's simply using the value it received, and it
has no way of knowing that another value was input and discarded by the browser.

And Then... . . .

This is the part that is different for each different script. The entire preceding section is a

fairly generic description, applying to all forms of this type. What each CGI program does

is up to its author. For example, let's say we have a program which is supposed to take the

name, rank, and serial number and mail the information to an e-mail address.

For the purposes of this example, assume the CGI program is running on a UNIX-based
server. The first thing the program does is create a text file containing the information with

appropriate labels. The file would look something like this:

The following information was input by the user...

Name: Eric

Rank: Very Low

SN: 123-45-6789

The CGI program then sends this file over to sendmail, a common UNIX mail utility, along

with some subject and destination information which the CGI program has been written to

provide to sendmail. The file is then mailed to its intended destination, and arrives looking

something like this:

Date: Fri, 23 Feb 1996 10:35:00 -0500 (EST)

To: you@your.site

From: somebody@some.where.org

Subject: Data for user 'Eric'

The following information was input by the user...

Name: Eric

Rank: Very Low

SN: 123-45-6789

Ofcourse, as I have said, this is but one ofthe literally infinite number of things which CGI

programs can do. It's merely one of the most common.

ISISWWW

In the case ofthe isfrag.pl script it calls up ISIS for a short while, quenes the database with

the input received from the form, and the send the results back tothe broweser, where it

is displayed.

The FORM Tag

How does the browser know where a form begins and ends, and how does the browser

know where to send the data? Yes, to the CGI program, but where is that program

located? The data has to be sent to a specific location.

This is accomplished by using the <F0RM> tag. This tag has two attributes which must

be used if the form is to have any probability of working correctly. The attributes are

METHOD and ACTION

Here's what an empty form would look like:

<F0RM method="POST" action='7cgi-bin/programlM>

</F0RM>

METHOD has two possible values: GET and POST. Ifyou want the data to go from the



browser to the CGI program, then use the method POST.
The ACTION attribute contains the URL of the CGI program which processes the data

sent by the browser. In the example above, the program (program 1) resides in the cgi-bin

directory ofthe server which contains the form itself. The value of ACTION can be either

a relative or a full or absolute URL.

Any tag which is allowed inside of the <BODY> container is allowed inside a form.

Headings, paragraphs, lists, tables, images, links. In addition, there are certain tags which

are allowed to exist inside a form, and nowhere else.

HTML tags which create form elements

INPUT

There are several types of form input, such as:

► text entry fields

► individual and multiple-select menus

► checkboxes and radio buttons

► submit and clear buttons

Each ofthese inputs works differently, and you will learn which is the best to use for your

input information.

INPUT
The most commonly used form tag is INPUT. This is because there are several types of

INPUT, like open text inputs, radio buttons, and checkboxes. The type of input is

specified using the TYPE attribute. We'll start with text inputs.

Text

A text input is simply a box in which anything can be typed-- letters, numbers, or anything

else- via the keyboard. In most browsers, the box is twenty characters wide, but this can

vary. The markup and its effect:

<FORM>

<INPUT type-'text" name=1'socsec1l>

</FORM>

I chose the name ofthe input for a reason, "socsec" is short for "Social Security,11. Now,

a twenty-character input is a little large for a nine-digit number. It would be nice to have

an input which is nine characters wide. This is accomplished using the SIZE attribute. The

value of SIZE is a positive integer and translates into the width of the input box. This

width is expressed as a number of characters. Therefore, SIZE=9 means the input will be

nine characters wide.

<FORM>

<INPUT type="text" name=" socsec" size=9>

</FORM>

This causes the input box to be nine characters wide. This does not, however, restrict the
number of characters which can be input. The user can keep typing past nine characters.

You can limit the number of characters which may be input by using the MAXLENGTH

attribute. The value of MAXLENGTH is expressed as a number of characters, just as

SIZE is. We not only want the box to be nine characters wide, but the maximum number

ofcharacters which can be input to also be nine. The tag and its resulting input box would

be:



<FORM>

<INPUT type=Mtext" name="socsec" size=9 maxiength=9>

</FORM>

Maxiength and size do not have to be equal.

Password

Password inputs are similar to text inputs, in that they accept any input from the keyboard,

they can have SIZE and MAXLENGTH attributes, and (as always) they require names. The

difference is that when the user types in a password field, the computer displays bullets or

asterisks instead of the characters being typed.

A typical password input would look like this:

<FORM>

<INPUT type="password" name="pwd" size=15 maxlength=15>

</FORM>

However: this 'visual security' is the furthest extent of the security afforded by the

password input. There is absolutely no encryption of any kind whatsoever. Information

entered into a password input is still sent to the CGI program 'in the clear;' that is, as plain

text. This makes it vulnerable to security attacks such as packet sniffing, which are

uncommon but not unheard of.

Text inputs are appropriate for certain kinds of questions, but sometimes, as with

multiple-choice questions, you want to provide a limited number of responses.

Radio Buttons

This INPUT type is used when you want the user to select one of a limited number of

choices. For example, suppose you wanted to find out which computer operating system

your users prefer. Ofthe six options provided, the user should only be able to pick one.

<FORM>

Your favorite computer operating system:

<INPUT type="radio" name=1tfav_os" value="mac">Macintosh

<INPUT type="radioM name="fav_os" value="dos">DOS

<INPUT type="radio" name="fav_os" value="win">Windows

<INPUT type="radio" name="fav_os" value="win95">Windows95

<INPUT type="radio" name="fav_os" value="os2">OS/2

<INPUT type="radio" name="fav_os" vaiue="unix">UNIX

</FORM>

Only one option can be chosen. If an option is already selected, then choosing another

option will de-select the previously chosen option and select the new option. Since there

is nowhere for the user to enter a value, however, the value of each option must be

specified in the HTML markup itself, using the VALUE attribute. The use ofthe VALUE

attribute is required for radio-button inputs. The entire set of INPUT tags shown above

may be considered to constitute one input - we can call it a "logical input." A logical input

may be composed of many, many INPUT tags, but it will still return only ONE value,

which is the value of the option selected by the user. It is mandatory that each of the

INPUT tags in a radio-button logical input have the same name. Otherwise, the browser

has does not know that the different INPUTS are ail part ofthe same logical input. When

you select a radio button, the browser checks to see if any other radio buttons with the

same NAME are selected. If yes, it de-selects that button for you automatically.



Checkboxes

Ifwe want to let the user select more than one option at a time, we can use Checkboxes.

The HTML markup for a checkbox logical input looks very similar to that for radio

buttons. The only structural difference is the use of TYPE="checkbox" instead of

"radio". Assuming that not only do we want to know which OS the user prefers (see

above), but we also want to know which ones they've used, so that we can draw some sort

of correlation between the two.

Once again, VALUE is required for each INPUT tag, because the user has no way to input

any values himself- merely to select from a list of options. In a checkbox logical input,

the user can select some, or all, or none of the options provided.

<FORM>

What operating systems have you used?

<INPUT type="checkbox" name=Mos_usedM vaIue="mac">Macintosh

<INPUT type-1checkbox" name-'os_used" value-'dos">DOS

<INPUT type="checkbox" name="os_used" value="win">Windows

<INPUT type="checkbox" name="osjased" value="win95">Windows95

<INPUT type="checkbox" name="os_used" value="os2">OS/2

<INPUT type="checkbox" name="os_used" value="unix">UNIX

</FORM>

How do multiple responses get transmitted if there's only one value allowed for a given

name? Assuming that the user checks the boxes for Macintosh, DOS, and Windows95.

The value ofos_used would be mac j dos I win95, where the I represents a separator

(usually a null character). There is one value for the NAME defined as os_used, but it

contains all ofthe options which the user selected. The CGI program will need to be able

to take the value and split it up into its components. Fortunately, most CGI languages

have libraries which were written to accept form-entered data, so this should not be a

problem.

CHECKED attribute

You can present the user with pre-selected options, so that even if he doesn't touch any of

the options, a given value will still be returned. This is accomplished by using the

CHECKED attribute. Simply adding this attribute to a radio or checkbox INPUT tag will

cause that INPUT to be selected as soon as the page is loaded as the default value for that

input..Suppose you're going to ask a question you're pretty sure you know the answer to,

but can't be completely certain.

<FORM>

Are you breathing at the moment?

<INPUT type="radio" name="breathing" value="Y" checked>Yes

<INPUT type="radio" name="breathing" value="N">No

</FORM>

Obviously, you will want to use CHECKED on only one option in a radio-button logical

input, as shown above, but multiple checkboxes in a given logical input could be set as

CHECKED.

SELECT

Suppose you want to have your readers indicate which country they live in. You could

create a radio-button input listing all two-hundred-plus countries in the world, but that

would obviously take up a lot of space on the screen. To avoid this unsightly screen, you



could use a SELECT list. This will create a pop-up list from which any one option may be

selected. The advantages are that you still have a list to choose from, but it takes up very

little screen space until the user interacts with the list.

Let's ask the user what kind of connection he's using to get his Internet feed. Select the

line "No response" which appears right after this paragraph.

<FORM>

How are you reaching this page?

<SELECT name="access">

<OPTION>No response

<OPTION>Compuserve

<OPTION>America On-Line

<OPTION>Local ISP

<OPTION>National ISP

<OPTION>Straight Internet connection

<OPTION>I don't know

<OPTION>None

<OPTION>Other

</SELECT>

</FORM>

You can change the current option by selecting the list and moving through it until you get

the choice you want. How is this done?

There are a few things to mention. First, the required presence of a NAME attribute in the

SELECT tag; in this case, the NAME is access. Second, is that SELECT is a container,

requiring a close tag (</SELECT>). Third, the size of the list-box is as wide as the

longest option in the list. Fourth, the browser will typically set the list to the first OPT ION

(although there are ways to change this behavior; we'll get to that in a moment). Finally,

between the open and close tags of the select list are

OPTION Tags

Each choice in the select list is defined using the OPTION tag. Note that there is no

VALUE attribute throughout the list. That's because the text after the OPTION tag is

taken as the value ofthe selection. So if I were to pick the option "Local ISP," the value

of access would be Local ISP. Thus, aVALUE= statement is not required. This does

not mean it is forbidden, however. It is still possible to explicitly assign values to some,

or all, or none of the options in the list. Let's say that I wanted to set the values of the

various choices to be one through eight, with zero for the "No response" choice. In that

case, I would set up the following:

<FORM>

How are you reaching this page?<BR>

<SELECT name="access">

<OPTION value-'0">No response

<OPTION value-' 1 ">Compuserve

<OPTION value="2">America On-Line

<OPTION value="3">Local ISP

<OPTION value="4">National ISP
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<OPTION value="5">Straight Internet connection

<OPTION value="6">I don't know

<OPTION value="7">None

<OPTION value="3M>Other

</SELECT>

</FORM>

Selecting "National ISP" would set access to a value of 4. There is no change in what

the user sees in terms of the options presented, but the data returned to the CGI program

is definitely different. You can never use any HTML tags (other than OPT ION) within the

SELECT container.

SIZE Attribute

Suppose that we don't want to use a l(pop-up" list, but instead want a scrollable list. For

example, returning to the 'countries ofthe world' list, Many browsers can't display a pop-up

list that long. Instead, we want a list which will not display the whole list at once, but we

can still scroll through it, and are able to see a portion of it at any time.

This is accomplished using the SIZE attribute in the SELECT tag. The number specified

by SIZE sets the number of lines of text which are displayed at once. We will use a list

of the50 states of the USA because it is shorter:

</FORM>

<FORM>

<SELECT name="state" size=10>

<OPTION>Alabama

<OPTION>Alaska

<OPTION>Arizona

<OPTION>Arkansas

<OPTION>Califomia

<OPTION>Colorado

<OPTION>Connecticut

<OPTION>Delaware

<OPTION>Florida

<OPTION>Georgia

<OPTION>Hawaii

<OPTION>Idaho

<OPTION>Illinois

<OPTION>Indiana

<OPTION>Iowa

<OPTION>Kansas

<OPTION>Kentucky

<OPTION>Louisiana

<OPTION>Maine

<OPTION>Maryland

<OPTION>Massachusetts

<OPTION>Michigan

<OPTION>Minnesota

<OPTION>Mississippi

<OPTION>Missouri
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<OPTION>Montana

<OPTION>Nebraska

<OPTION>Nevada

<OPTION>New Hampshire

<OPTION>New Jersey

<OPTION>New Mexico

<OPTION>New York

<OPTION>North Carolina

<OPTION>North Dakota

<OPTION>Ohio

<OPTION>Oklahoma

<OPTION>Oregon

<OPTION>Pennsylvania

<OPTION>Rhode Island

<OPTION>South Carolina

<OPTION>South Dakota

<OPTION>Tennessee

<OPTION>Texas

<OPTION>Utah

<OPTION>Vermont

<OPTION>Virginia

<OPTION>Washington

<OPTION>West Virginia

<OPTION>Wisconsin

<OPTION>Wyoming

</SELECT>

</FORM>

In this case, the browser has been told to show 10 lines, so we see twenty percent of the

total list at any time (10 out of 50). SIZE can be set to any positive integer, although

going past twenty is generally discouraged.

As you have no doubt figured out by now, a SELECT list is functionally equivalent to a

radio-button input. The user can only select one choice, and selecting a new choice

de-selects the old choice. There is also a type of list which is equivalent to a checkbox

input, but it doesn't use a new tag. Instead, it's a variant on SELECT.

MULTIPLE Attribute

In order to create a list in which multiple selections can be made, simply add the

MULTIPLE attribute to the SELECT tag. This will let the user select more than one

choice, and in some browsers they'll be able to do range-selections, and so on.

We'll use the list offifty states again, but this time we'll ask the user to indicate which ones

he has visited.

HTML Markup:

<FORM>

<SELECT multiple name=" state" size-10>

[ the 50 states]



</SELECT>

</FORM>

If you're using a graphical browser, try scrolling around in the list and shift-clicking on

different options. Then try control-clicking. Try clicking on already-selected options,

using one or the other of the modifier keys. Just like checkboxes, you can select or

de-select options at will.

SELECTED

How can we specify a default choice? Returning to the first example list, the one about

access methods, let's assume that I want to make the default choice to be the last option,

"Other." However, I don't want to move it to the top ofthe list for some reason. In that

case, I would simply use the attribute SELECTED. Thus:

Markup:

How are you reaching this page?

<FORM>

<SELECT name="access">

<OPTION>No response

<OPTION>Compuserve

<OPTION>America On-Line

<OPTION>Local ISP

<OPTION>National ISP

<OPTION>Straight Internet connection

<OPTION>Don'd know

<OPTION>None

<OPTION selected>Other

</SELECT>

</FORM>

Obviously, only one SELECTED should be used in a normal SELECT list, whereas you

could use SELECTED on many different options in a SELECT MULTIPLE list.

TEXTAREA

The TEXTAREA tag is used to create a box where the user may type large amounts oftext

at will. Atypical use for TEXTAREA is to ask users to input general comments they may

have about a Web site. TEXTAREA is a container, so the close-tag is required.
<TEXTAREA name= "comments" rows=5 cols=65X/TEXTAREA>

Special attributes for TEXTAREA are, ROWS and COLS. These specify the number of

rows high and columns wide the textarea should be. The numbers are measured in

characters, so ROWS=5 makes the box five lines high, and COLS=65 means that the box

will be 65 characters wide. This will cause the box to grow or shrink depending on the size

of the monospace font set by each user.

To make the example a bit more real:

<FORM>

<TEXTAREAname-'comments" rows=5 cois=65>

</TEXTAREA>

</FORM>

The input is not limited to the number of rows and columns specified in the tag; a line can



be longer than the width ofthe box, and there can be more lines than the height of the box.

The user is basically given an interactive area of preformatted text to play with- all ofthe
rules ofthe<PRE> tag apply within. One may wonder why textareas are containers. After

all, the close tag doesn't seem to serve much purpose. Actually, it does. If you want to

insert some text into the textarea as a default, it would go between the open and close tags.

<FORM>

<TEXTAREA name-'comments" rows=5 cols=65>Please type here...

</TEXTAREA>

</FORM>

Again, preformatted-text rules apply within the textarea. If you put a return between the

open tag and the enclosed text, then the text will appear on the second line ofthe textarea.

INPUT Redux

Hidden

The first type is hidden. It does exactly what it sounds like: it allows for an input which

is hidden from the user. Hidden inputs are completely hidden from the user-- there is no

way to affect the value of the INPUT, which is why assigning an explicit value is

important. Otherwise, the value of the input will be literally nothing. Take a look:

<FORM>

<INPUT type-'hidden" name="sendTo" value="eam3@po.cwru.edu">

</FORM>

The next question which usually gets asked is, "What's the point? What's it good for?"

Well, what it's good for is to pass information to the CGI program which does not and

should not change, but is for some reason important. For example, ifwe selected a page

for the searching of a specific database, e.g. CDS, it is not necessary that the user has to

select it again, but by using the hiden and setting the value to CDS, it is passed to the CGI

script.

Submit and Reset [stM^ V^ ^ (v^ ")
Letting the user input data in a variety ofways, but what good are they if the user can't tell

the browser when to send the data offto the CGI program? And what if the user realizes

he made several mistakes and just wants to start over instead of correcting each one of the

mistakes he made?

That's what the INPUT types "submit" and "reset" are for. These INPUTS do not need

names, as they do not generate any data to be sent. Their functions are to affect the rest

ofthe form.

First, submit inputs are the user's way of saying, "I'm done now, send it" The HTML tag
<INPUT type="submit">

will create a button on the screen which says something like "Submit Query" (the actual

label may vary). Selecting a Submit button triggers the posting of the input data to the

CGI program.

Similarly, the markup...
<INPUT type="reset">

places a button which is labelled something like "Reset Form" (the actual label will vary).

Selecting the button will cause the entire form to be reset to its default state, wiping out



any and all changes made by the user.

Usually, the two buttons are placed together at the bottom of a form, but there is nothing

which says they have to go together, or at the bottom of the form. That's a matter of

custom more than anything else. You could put them at the top of the form, or in the

middle, or separate them by entire paragraphs, or have multiple Submit and Reset

buttons sprinkled throughout the form.

Most people feel that the default labels which browsers give to these buttons are pretty

boring.

Fortunately, you can change those labels by using a VALUE attribute. For example:

<INPUT type="submit" value="Search the database">

<INPUT type-"reset" value="No, Wait, I'll try again">

The functions of the buttons are, of course, still the same.

Values-

There is another way you can use the VALUE attribute with an INPUT tag. If you assign

a value to a text or password input, then it will appear in the input box by default

<FORM>
<INPUT type="text" name=Mgreet" value="Hi there!">

</FORM>

The user is perfectly free to add to, alter, or completely replace the contents of the input

box if he feels like doing so, of course. If he does nothing to the contents of the input,

then its predefined value will be used when the form is submitted.



FORMS Quiz

Now that you have finished going through ail of the matenal to be learned, you are ready for a short quiz on the

markup tags.Ifyou don't feel you are familiar enough with the matenal, you can still go back and refresh your

memorv. After ail, we're trying to get you to learn something here!

Instructions

In the text entry fields, enter the name of the markup tag that produces the desired ihput type.

Example: [_,.

Your Answer:

Example:

Your Answer:

Example:

Your Answer:

********;

Example:

Your insurer:

Example: l0PtiQn_}

Your Ansuer:

Example: D Select this

Your Answer:

Example: <£ one 0 tuo

j ji
Your Answer: ] *
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